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Overview

The following subsection gives you information that you need to prepare your 
system for installing a RocketPort adapter.

How to Use this Document

You can use the interactive Table of Contents to locate the information you need.  

Driver Requirements

This document discusses installing and configuring the RocketPort  and 
RocketModem device driver for the Windows 2000 operating system. The 
RocketPort or RocketModem requires at least one host system running Windows® 
2000.
Note: This driver supports only one ISA adapter.

Locating Current 
Drivers

An upgraded driver may be available from the following:
• Downloaded from the Comtrol ftp/web site.
• Contained on Comtrol media shipped with the product.
Unzip the file into a new subdirectory, for example: \Comtrol.
Always check the web or ftp sites to make sure that you have the current driver 
and documentation.

Driver Features

This driver has the following features:
• Can be installed on multiple systems.
• Supports up to 128 RocketPort or RocketModem ports per system.

Note: The critical limit is the number of ports your system can support. In 
most applications, this is defined by the number of RAS port supported, 
which is typically 256 ports per primary system.

• Allows you to inter-mix RocketPort and RocketModem ports.

Locating Hardware Installation Documentation

For hardware specific information or product information, see the hardware 
installation documentation that is available on the Comtrol CD shipped with your 
product, or you can download the current version from the ftp/web site.
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Upgrading Your Operating System to Win2000
Upgrading Your Operating System to Win2000

If you are upgrading from another operating system, follow these steps:
Note: Do not use the Update Driver feature in the Device Manager to upgrade the 

driver.
1. Before upgrading the operating system, remove the driver from the Windows 

95/98 or Windows NT operating system. See the Removing or Disabling the 
Adapter discussion.

2. Turn off the system, remove the boards, and set them aside.
3. Upgrade your system to Windows 2000.
4. Install the adapters and turn on the system.

Note: If you need information about re-installing adapters, see the Hardware 
Installation documentation. 

5. Use the Installing the Driver and Removing or Disabling the Adapter 
discussions to set up the new driver.
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Driver and Adapter Information

The following subsections discuss driver and adapter installation and removal. It 
also discusses adapter and port configuration. If you have installation problems, 
see the troubleshooting subsection.

Removing or Disabling the Adapter 

Adapters cannot be removed through the Main Setup window. Use the following 
procedure to remove adapters:
1. On the Windows desktop, right-click on the My Computer icon and select 

Manage.
2. Double-click on the Device Manager.
3. Open the Multi-port serial adapters entry (select the [+] button to expand the 

list).
4. Right-click on the adapter you want to disable or uninstall.
5. Select on one of the following:

• Disable to disable the device in the current hardware profile but not remove 
it. To update the driver from the ftp/web site, you must first Disable the 
driver and then use the Device Manager to Update the driver.

• Uninstall to completely remove the adapter.
• Properties to display the Device Properties window.
Note: If you prefer, you can disable or enable the adapter by changing the 

Device Usage field on the Device Properties window, General tab.
6. Exit the Device Manager window and resume normal operations.

Installing the Driver

Adapters cannot be added through the Device Manager or Main Setup window. 

PCI Adapters The computer's Plug and Play feature should recognize the PCI adapters, which 
should automatically launch the Found New Hardware Wizard. If Windows 2000 
does not recognize your PCI adapter, or if you have installed an ISA-bus, follow the 
procedure below.
To install the driver for a PCI adapter, first install the adapter using the hardware 
installation documentation. The system should automatically install the driver. 
You may need to configure device or port properties.
If you want to upgrade to the latest driver from the ftp site, upgrade the driver 
before configuring the device or port properties. 
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PCI Adapters
If the operating system finds the adapter but not the driver, use the following 
procedure:
1. The Found New Hardware Wizard starts.

2. If you have not copied the most recent version of the driver on to the hard 
drive, do it now. 

3. Select the Next button
4. Select the Display a list of the known drivers for this device so that I 

can choose a specific driver option. Select the Next button.
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PCI Adapters
5. Select the desired adapter from the Models list. Select the Have Disk button.

6. Select the Browse button to display the Open window. Go to the directory 
where the driver files are located and select the OK button.

7. The Install from Disk page reappears. Select the OK button.

8. The Select a Device Driver page reappears. Confirm that the desired adapter 
is selected, and select the Next button.  
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PCI Adapters
9. Select the Next button to start the installation process.

10. If the procedure displays the Digital Signature Not Found dialog box, select 
the Yes button to complete the driver installation.

11. Select the Finish button.The new driver is now installed and the system 
starts to configure the COM Ports. 
Note: You may have to shut down and restart your system before the changes 

take effect.
Driver and Adapter Information 6 



ISA Adapters
ISA Adapters Before installing the driver, you should install the hardware and restart the 
system. To install the driver, use the Add/Remove Hardware wizard. 
Note: This driver only supports one ISA adapter. If installing an ISA board, you 

must set the I/O DIP switch and you may need to change the software 
setting. See Setting I/O Addresses and DIP Switches (ISA Only), if 
necessary. 

1. On the Windows desktop, right-click the My Computer icon.
2. Select the Properties button.
3. Select the Hardware tab.
4. Select the Hardware Wizard button.
5. Select the Next button when the Add/Remove Hardware wizard appears.
6. Select the Add/Troubleshoot a device option and the Next button.
7. Select the Add a new device option and the Next button.
8. Select the No, I want to select the hardware from a list option and the Next button.
9. Highlight Multi-port serial adapters when asked to choose the type of hardware 

to install and the Next button. 
Note: All Comtrol products are considered multi-port serial adapters.

10. Select Comtrol Corporation as the manufacturer, the appropriate Comtrol 
product you wish to install, and the Next button.

11. Select the Next button at the Start Hardware Installation screen.
Note: It may take up to several minutes for Windows 2000 to load the driver.

12. Select the Finish button to complete the driver installation process.
Note: You may have to shut down and restart your system before the changes 

take effect.
After you complete driver installation, additional steps may be necessary to 
configure the ports through the Main Setup tab.
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Setting I/O Addresses and DIP Switches (ISA Only)
Setting I/O 
Addresses and DIP 
Switches (ISA Only)

This discussion concerns ISA adapters only. This driver supports only one ISA 
adapter. When you install an ISA adapter, you must set the base I/O address in 
two places
• In the driver software
• On the adapter itself, using a block of DIP switches.

Software I/O 
Address

During installation, the software base I/O address is set to default values by the 
Add/Remove Hardware Wizard.
After you finish the software installation, you can use the Device Properties 
Resources tab to view or change the Input/Output Range resource setting. If the 
default values prove incorrect:
1. Select the Input/Output Range from the Resource Type list.
2. Select the Change Setting button.
3. You may need to choose a hardware configuration from the Setting Based On 

drop-down list box to activate the Edit Input/Output Range widow.
Note: The I/O range setting is based on your hardware configuration setting. You 

can have multiple hardware configuration settings, and this control may be 
locked in some configurations.

Hardware I/O 
Address

The hardware base I/O address is set using a block of DIP switches on the adapter 
circuit board. See your Hardware Installation documentation for instructions on 
how to set the DIP switches.
The software and hardware I/O address settings must match each other. For 
example, if you set the DIP switches to 180 (hex), you must select 180 (hex) in the 
software.
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Upgrading the Driver
Upgrading the Driver

Use this procedure if you want to upgrade the driver in the Windows 2000 
operating system. 
Use the following procedure to install a new driver:
1. Unzip the file into a new subdirectory, for example: \Comtrol.
2. On the Windows desktop, right-click on the My Computer icon and select 

Manage.
3. Select the Device Manager.
4. Open the Multi-port serial adapters item.
5. Right-click the device entry for which you want to update the driver, and select 

the Disable option. 
Note: All Comtrol products are considered multi-port serial adapters.

6. Select Yes when the following dialog box appears:

7. Double-click on the disabled device, and select the Driver tab.
8. Select the Update Driver button.
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Upgrading the Driver
9. Select the Next button to start the Upgrade Driver Wizard.

10. Select the Display a list of the known drivers for this device so that I can choose a 
specific driver option and the Next button.
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Upgrading the Driver
11. Select the Have Disk button. 

12. Browse to the location of the driver file that you extracted, and then select the 
Open button.

13. Select the OK button.

14. Highlight the device and select the Next button.
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Upgrading the Driver
15. Select the Next button.

16. Select Yes at the Digital Signature Not Found dialog box.

17. Select the Finish button to complete the driver installation process.
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Accessing the Main Setup Tab
18. Select the Close button when you return to the Properties window.
19. Select Yes to restart your system.

20. After you restart the computer, return to the Device Manager, and select the 
Enable option for the adapter.

After you complete the driver installation, additional steps may be necessary to 
configure the ports using the Main Setup tab.

Accessing the Main Setup Tab

1. On the Windows desktop, right-click the My Computer icon and select Manage 
from the short-cut menu.

2. Select the Device Manager entry.
3. Select the [+] button for the adapter under Multi-port serial adapters to 

expand the view.
4. Right-click the adapter that you want to access and select Properties from the 

short-cut menu.

5. Select the Main Setup tab.

Note: For information on using port options, use the context-sensitive help in the 
Main Setup or Options tabs.
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Changing Device Properties
Changing Device Properties

You can change the following device properties:
• Device name
• Starting COM port number.
In addition, you can configure primary and back up systems and establish a time 
out period.
To change device properties, follow this procedure to access the Device Setup tab:
1. Access the Main Setup tab. 
2. Highlight the device name and select the Properties button.

3. After making your changes, select the OK button and follow any other driver 
prompts.
Note: Select the Help button if you need detailed information about 

procedures or use context-sensitive help for any field.
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Configuring Device Properties
Configuring Device Properties

You can optionally configure the following Device Properties:

• Verbose event log for diagnostic purposes.
• Scan rate to adjust latency for timing-critical applications.
• Enable RS-485 mode.
To set the previous options, use the following procedure:
1. Access the Main Setup tab. 
2. Select the Options tab.
3. Enable the features you want to use.
4. If you enable the RS-485 feature, an RS485 tab appears behind the Port Setup 

tab that you may need to configure.
Note: Select the Help button if you need detailed information about 

procedures or use context-sensitive help for any field.
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Configuring Port Properties
Configuring Port Properties

You can also configure specific port properties for this adapter:

• Override and lock baud rate to ...
• Timeout on transmit data on port close
• Map CD to DSR
• Map 2 stop bits to 1
• Wait on physical transmission before completing write
• Emulate modem hardware RING signal
• Clone all Comtrol ports for this system
Use the following procedure to access the Port Properties tab:
1. Access the Main Setup tab. 
2. Highlight the port you want to configure and select the Properties button.
3. Enable the features you want to use and select the OK button. To configure all 

ports on the adapter with the same features, select the Clone check box.
Note: Select the Help button if you need detailed information about 

procedures or use context-sensitive help for any field.

Adding Additional Adapters

Install the adapter and configure the ports.
Note: This driver supports only one ISA adapter.
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Configuring Modems Overview

After installing the hardware and driver for Windows 2000, you can use this 
discussion to configure modem COM ports.

Installing Modems

The following instructions were developed using Comtrol modem products. If you 
are using another brand of modem, note that some prompts and screen 
descriptions may differ from those shown.
Follow these steps:
1. Connect the modem to the desired port.
2. Turn on the modem.
3. Open the Control Panel window and double-click the Phone and Modem Options 

icon. Select the Add button. The Add/Remove Hardware Wizard starts.
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Installing Modems
4. Select the Don’t detect my modem; I will select it from a list check box, 
and select the Next button.

Note: While Windows 2000 can automatically detect modems, we advise 
against using this option as auto-detect feature may cause some 
multiprocessor systems to lock up.

5. Select the appropriate manufacturer and model, and select the OK button. If 
the correct manufacturer and model do not appear on the list, select the Have 
Disk button to install software from a manufacturer-supplied installation 
diskette.
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Installing Modems
6. Select the port you to which you want to install the modem. Select the Next 
button 

7. Select the Finish button. The modem software is installed on the selected ports.

Note: For help configuring modem properties, see the Windows Help system.
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Installing Modems
8. If you need to configure dialing properties (country, area code, calling card 
number, and so on), select the Dialing Rules tab, make the needed changes, 
then select the OK button.

9. When the Phone and Modem Options window reappears, select the Close 
button.
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Comtrol Tools

This section discusses the following utilities that are installed with most Comtrol 
drivers for Microsoft operating systems:
• Test Terminal program (wcom32.exe), which can be used to troubleshoot 

communications on a port-by-port basis (Using Test Terminal on Page 23).
• Port Monitor program (portmon.exe), which checks for errors, modem control, 

and status signals (Using Port Monitor on Page 26). In addition, it provides 
you with raw byte input and output counts.

• Peer Tracer program (peer.exe), which traces driver events (Using Peer Tracer 
on Page 31).

Note: If you are using a device driver for the Windows 2000 or Windows XP 
operating system, you may need to download and install these utilities.

Installing the Utilities (Windows 2000 and Windows XP)

You can download the latest Comtrol Utility package from ftp://ftp.comtrol.com/
Utilities/ or locate the Utilities directory at the root of your Comtrol CD.
Use the following procedure to install the Comtrol Utilities:
1. Run the self-extracting utility file. 

You can optionally change the path 
that you want to extract the files.
Note: Allow WinZip to run the 

COM_util.exe file to start the 
Utilities installation.

The file name may be different 
than the illustration.

2. Select the Next button to begin the 
Comtrol Utilities installation.
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Installing the Utilities (Windows 2000 and Windows XP)
3. Select the Next button to install the Utilities in the default subdirectory.

4. Select the Next button to begin the installation.

5. Select the Finish button to complete the Utilities installation.
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Using Test Terminal
Using Test Terminal

WCOM32 is a terminal program that enables you to open a port, send characters 
and commands to the port, and toggle the control signals.
Note: WCOM32 will not work on ports used by RAS if Remote Access Service is 

running or any other application is using the port. If you are using RAS, 
you must stop the service before starting WCOM32 to test RAS COM ports. 
To test ports that are not used by RAS, you do not need to stop RAS.

Follow these steps:
1. Start Test Terminal (wcom32.exe) from the Comtrol program group for your 

product.

2. Select the OK button if this screen appears:

3. From the Port menu, select Open Port. A list of possible COM port numbers 
displays.

4. Select the COM port you want to test.

If the COM port does not exist or if it is currently being used by another 
program, a Create File Error message displays.

Product Operating 
System Program Group

RocketModem and 
RocketPort

Windows 98, 
Windows NT

Comtrol RocketPort RocketModem 
Test Terminal

RocketModem and 
RocketPort

Windows 2000, 
Windows XP

Comtrol Utilities Wcom32 
wcom32.exe

DeviceMaster RTS, 
RocketPort Serial Hub ia, 
and RocketPort Serial 
Hub Si

Windows 98, 
Windows NT, 
Windows 2000, 
Windows XP

Comtrol NS-Link Test Terminal
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Testing a Comtrol Device
If the COM port is available, a terminal window appears:   

Note: Notice the <loop> button in the terminal window. If this option is 
activated, it is green and uppercase ( ), the COM port internal 
loopback feature is activated, and the data is returned by the COM port 
hardware. If this option is deactivated, it is gray and lowercase ( ), 
the internal loopback is deactivated, and the data is sent out of the COM 
port.

Testing a Comtrol 
Device

Use the following procedure to test the Comtrol device.
1. Place a loopback plug on the COM port that you are testing. Make sure all 

connectors are seated firmly and that the loop button is off. 
Note: Test terminal works for RS-232 and RS-422 mode.
To build loopback plugs, see the hardware installation document for the 
Comtrol device.

2. From the Port menu, select Send Test Data. The program sends out a repeating 
data stream. 
Note: To stop the data stream, select the Send Test Data option again. 
• If the loopback plug is in place and the port is working correctly, the test 

data should be echoed back to the screen. 
• If the loopback plug is not in place or the port is not working correctly, no 

data or garbled data is echoed back to the screen. 
Note: If no characters appear, try putting the loopback plug on an adjacent 

port. It may be that you have the ports mixed up. 
3. If further testing is required, select Loopback Test from the Port menu. 

If the loopback plug is in place and the port is 
working correctly, the system should return 
the message Passed.
If the loopback plug is not in place or the port 
is not working correctly, the system will return 
the message Failed. 
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Testing a Comtrol Device (RS-485)
Testing a Comtrol 
Device (RS-485)

Perform the following procedure to determine if a port or ports are functioning 
properly.
1. Connect a straight-through cable from Port 1 to Port 2. 

Note: See the hardware installation document for the Comtrol device if you 
need to build a cable.

If testing ports other than Ports 1 and 2, simply connect the cable 
between any two ports.

2. Open a session for each port.
3. Enter data into the Port 1 session. The data should appear in the Port 2 

window.
4. Enter data into the Port 2 session. The data should appear in the Port 1 

window.
Note: If the data appears as described in Steps 3 and 4, the hardware is 

functioning properly.

Test Terminal 
Modem Control 
Signals

The terminal window displays the modem control signals as gray 
or green lights at the top of the window. The first four are inputs: 
The lights are green if they are turned on, or gray if turned off. 
The text on the light also changes from uppercase (CTS), which is on, to lowercase 
(cts), which is off.
The next two lights are outputs:  
Note: If you have a loopback plug connected and you click on one of the outputs, 

the corresponding signal is sent to the input and the input lights should 
toggle accordingly.

The right most light is the loop indicator:  
If this is on, the COM port internal loopback feature is activated and any 
information or code entered in the terminal window loops back through the COM 
port circuitry. If this is off, the COM port internal loopback is deactivated, and any 
information or code entered in the terminal window is sent out of the port.
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Using Port Monitor
Using Port Monitor

The Port Monitor program (portmon.exe) offers a summary of all Comtrol device 
statistics in one spreadsheet view. It also enables you to verify operation of all 
Comtrol device ports from a single window. 
The Port Monitor display follows the familiar spreadsheet model: each COM port 
is a horizontal row, and each vertical column displays a variable or value for the 
respective COM port. For definitions of the abbreviations used, see Port Monitor 
Variables on Page 29.
Port Monitor can also produce statistics and reports that can help you verify the 
operation of the COM ports and connected peripherals. Some immediate feedback 
includes:
• The state of the modem control and status signals
• Open ports
• Raw byte input and output counts obtained from the device driver
• Port errors
The available statistics include:
• Instantaneous characters per second (CPS) calculations
• Minute, hour, and day CPS averages and peaks
• Carrier detect (CD) signal runtime and transition count
Reports can be automatically generated on an hourly and/or daily basis, and can 
cover all ports collectively or a separate report for each port. You can also set how 
often the values are recalculated, fine-tuning thoroughness against system 
efficiency, and automatically run external batch files to perform additional 
processing and analysis.

Starting Port 
Monitor

To run Port Monitor, select Port Monitor (or Portmon.exe) from the appropriate 
Comtrol program group. 

The Port Monitor window appears:

Note: To change the appearance of the window, see the following discussion.

Product Operating 
System Program Group

RocketModem and 
RocketPort

Windows 98, 
Windows NT

Comtrol RocketPort RocketModem 
Port Monitor

RocketModem and 
RocketPort

Windows 2000, 
Windows XP

Comtrol Utilities Portmon 
Portmon.exe

DeviceMaster RTS, 
RocketPort Serial Hub ia, 
and RocketPort Serial 
Hub Si

Windows 98, 
Windows NT, 
Windows 2000, 
Windows XP

Comtrol NS-Link Port Monitor
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Changing Screen Appearance
Once the monitor window appears, Port Monitor is active and collecting data. If 
any cumulative data has been saved from previous sessions, it is automatically 
brought in and used.
Port Monitor continues to run and collect data until you terminate it, at which 
point all accumulated data is automatically saved for use in the next session.

Changing Screen 
Appearance

While Port Monitor is running, there are a number of commands and controls that 
change the appearance of the screen.

* The Reset command does not clear raw data from the calcs.dat file. It simply 
resets the selected display fields to their null values. For more information 
regarding calcs.dat, see page 29.

Column Setup When you select Add or Properties from the 
column pop-up menu, the Column Setup 
window appears: 
• Use the Input droplist to select the 

variable displayed in the column.
• Use the Type droplist to select the way in 

which the value displays: either as an 
integer, as an on/off state, as an integer 
with a kilo, mega, or giga suffix, or as an 
hh:mm:ss time stamp. This defaults to the 
appropriate type for the selected Input 
variable.

• Use the Name variable to change the 
column heading name.

• Use the Width variable to specify the column width in characters.

Desired Change Procedure

Change the monitor 
window font. Select Font from the Edit menu.

Change width of a 
single column.

Left-click on the column separator (vertical) line and 
drag it to the desired width.

Change column 
placement.

Left-click in the middle of the column you want to 
move and drag it to the desired location.

Remove a column. Right-click on the column you want to remove and 
select Remove from the pop-up menu.

Clear all fields and 
reset them to null 
values.

Right-click on the upper left cell in the table and select 
Reset from the pop-up menu.*

Clear any single field 
except the upper left 
cell.

Right-click on the field to be cleared and select Reset 
from the pop-up menu.*

Add a column.

Right-click on the column now occupying the desired 
location and select Add from the pop-up menu.
You are prompted to name the variable you want to 
display, as well as other information. (See the 
following Column Setup discussion.) 
After you click OK, the column is inserted in the 
selected location and the existing column is moved to 
the right.

Change other properties 
of a column.

Right-click on the column and select Properties from 
the pop-up menu. (See Column Setup, below.)
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Report Configuration
• Use Color0 to set the column character color when the value is zero.
• Use Color1 to set the column character color when the value is not zero.
• When done, click OK to save your changes and return to Port Monitor.

Report 
Configuration

To configure reports, select 
Config from the Edit menu. 
The Single report options cover 
all ports and are overwritten 
each time the reports are 
generated. The Multiple report 
options generate a separate 
report for each port, and each 
report file is appended each 
time the report is generated.
For Hour reports, use the Single 
and Multiple droplists to select 
whether you are generating 
single or multiple reports, or 
both. For each report type, 
select from the following types 
of data to include:
• None: no report is generated.
• Hour Data: only variables with “Hour” in the name are included.
• All Data: all variables are included.
• View Data: only variables that appear on-screen are included.
The External Program field is used to enter a command line to run another 
program after the hourly reports have been generated. For example, you can use 
this to run a batch file that performs custom report processing. The Test button 
causes the command line to be executed immediately.
For Day reports, the single and multiple droplists behave the same, but your 
choices are:
• None: no report is generated.
• Day Data: only variables with the words “Day” or “Raw” in the names are 

included.
• All Data: all variables are included.
• View Data: only the variables that appear in the Port Monitor window are 

included.
Likewise, the External Program field is used to enter a command line to be 
executed after the daily reports have been generated.
The Update Time option allows you to set the rate at which the port information is 
obtained and the calculations performed. There is a trade-off between Port 
Monitor efficiency and response time. If you are using Port Monitor to view the 
port activity on the screen, you may want to set the update time to 1 or 2 seconds, 
so that the screen is updated frequently. If you are concerned about the monitor 
program using CPU resources, set this to a higher value, (6 to 20 seconds) in order 
to decrease the time required by the program to perform the calculations and 
update the screen.
If Port Monitor is left active to generate reports, minimizing or reducing the 
display area of the program will help reduce the CPU overhead of updating the 
screen.
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Port Monitor Files
Port Monitor Files Port Monitor creates and uses the following files:
• portmon.vew

• calcs.dat

The default column layout is saved in portmon.vew. If you have been experimenting 
with the appearance of the monitor screen, you can use the File menu Save option 
to save your customized layout in another .vew file. You can retrieve this file later 
by selecting the Open option from the File menu, or you can select the View Default 
option from the Edit menu to retrieve portmon.vew and restore the default view.
All Port Monitor calculations are saved at program exit and on the hour in a 
binary file named calcs.dat. This enables you to halt Port Monitor execution 
without losing accumulated data.
Port Monitor also creates a \REPORTS directory. All hourly and daily reports are 
saved in this directory, under the following names:
• hall.txt — hourly single report
• dall.txt — daily single report
• hcomx.txt — hourly multiple reports, where x is the port number
• dcomx.txt — daily multiple reports, where x is the port number
Caution: Since multiple reports append new data each time they are written, the 

multiple report files grow in size. It is up to you to delete them 
periodically.

Some safeguards are built into the program to avoid filling up a hard disk drive 
due to growing report files. The monitoring program stops writing additional data 
to the multiple reports if they reach a size of 2 MB. Also, the program will not 
write out data files to the disk drive if the spare room on the drive is less than 2 
MB in size.
To view or edit an hourly or daily report, select the Edit Report option from the 
File menu, or use a system tool such as Microsoft Notepad.
For more information, see the Port Monitor Help file.

Port Monitor 
Variables

The following table lists Port Monitor variables. 

Variable Description

Open Open status, on if open, off if closed.

Cts Input CTS pin status.

Dsr Input DSR pin status.

Cd Input CD (carrier detect) pin status.

Rts Output RTS pin status.

Dtr Output DTR pin status.

TxTotal Total bytes transmitted.

RxTotal Total bytes received.

TxCPSInst Instantaneous average of transmit characters per 
second.

RxCPSInst Instantaneous average of receive characters per 
second.

Errors Total hardware receive errors (parity, framing, and 
overruns.)

TxMinCPS Last minute average of transmit characters per 
second.
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Port Monitor Variables
RxMinCPS Last minute average of receive characters per 
second.

TxCPSMinAvMax Peak TxCPSInst for the last minute.

RxCPSMinAvMax Peak RxCPSInst for the last minute.

TxCPSHourAvMax Peak TxMinCPS for the last hour.

RxCPSHourAvMax Peak RxMinCPS for the last hour.

TxCPSDayAvMax Peak TxMinCPS for the last day.

RxCPSDayAvMax Peak RxMinCPS for the last day.

TxTotalRaw Total number of transmit bytes raw data from the 
device driver.

RxTotalRaw Total number of receive bytes raw data from the 
device driver.

TxMinCnt Count of transmit bytes sent in last minute.

TxHourCnt Transmit bytes count sent in the last hour.

TxDayCnt Transmit bytes count sent in the last day.

RxMinCnt Receive bytes count sent in the last minute.

RxHourCnt Receive bytes count sent in the last hour.

RxDayCnt Receive bytes count sent in the last day.

TxMinCntWrk Transmit bytes count sent in this minute.

TxHourCntWrk Transmit bytes count sent in this hour.

TxDayCntWrk Transmit bytes count sent in this day.

RxMinCntWrk Receive bytes count sent in this minute.

RxHourCntWrk Receive bytes count sent in this hour.

RxDayCntWrk Receive bytes count sent in this day.

TxCPSMinAvMaxWrk Peak TxCPSInst for the current minute.

TxCPSHourAvMaxWrk Peak TxMinCPS for the current hour.

TxCPSDayAvMaxWrk Peak TxHourCPS for the current day.

RxCPSMinAvMaxWrk Peak RxCPSInst for the current minute.

RxCPSHourAvMaxWrk Peak RxMinCPS for the current hour.

RxCPSDayAvMaxWrk Peak RxHourCPS for the current day.

CDRuns Carrier detect turn-on count.

CDDayRuns Carrier detect turn-on count in the last day.

CDDayRunsWrk Carrier detect turn-on count in the current day.

CDRunTime Time in seconds carrier detect has been on.

CDHourRunTime Time in seconds carrier detect has been on in the 
last hour.

CDDayRunTime Time in seconds carrier detect has been on in the 
last day.

CDHourRunTimeWrk Time in seconds carrier detect has been on this hour.

CDDayRunTimeWrk Time in seconds carrier detect has been on this day.

StatusFlags Bit flags, Open, CTS, DSR, CD, RTS, DTR

Variable Description
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Using Peer Tracer
Using Peer Tracer

The Peer Tracer program (peer.exe) is specifically designed to view the internal 
operations of the device driver for the purpose of troubleshooting communications 
on Windows NT, Windows 2000, and Windows XP systems. Peer enables you to see:
• Receive and transmit data
• Internal driver event traces
• Advanced configuration and status information
Like Test Terminal, Peer acts as a simple terminal session, and is used to send and 
receive text information to and from the device driver. To use Peer, you type in 
commands, and status and information are sent back.
Unlike Test Terminal, Peer enables you to keep a continuous log of the commands 
sent and the results received in a file named peer.log. Comtrol Technical Support 
may ask you to run Peer in order to help diagnose reported problems.

Starting Peer Peer Tracer does not appear in most Comtrol program groups and you may need to 
start the application from the Windows Explorer. Use the table below to determine 
whether you can start Peer from a program group or where to locate the 
executable. 

To start Peer, you may need to open 
the Windows Explorer, access a 
specific directory, and double-click 
on peer.exe or start peer using the 
Comtrol Utilities program group. 
The Peer Tracer window displays (at 
right). 

TxPkts Raw count of total transmit packets sent.

RxPkts Raw count of total receive packets sent.

OverrunErrors Total count of receive overrun errors.

FramingErrors Total count of receive framing errors.

ParityErrors Total count of receive parity errors.

OverrunErrorsRaw Total count of receive overrun errors, from the 
device driver.

FramingErrorsRaw Total count of receive framing errors, from the 
device driver.

ParityErrorsRaw Total count of receive parity errors, from the device 
driver.

Variable Description

Product Operating 
System Starting Peer

DeviceMaster RTS, 
RocketPort Serial Hub ia, 
RocketPort Serial Hub Si

Windows NT, 
Windows 2000, 
Windows XP

\WINNT\system32\rpshSi\peer.exe

RocketModem and 
RocketPort Windows NT \WINNT\system32\rocket\Peer.exe

RocketModem and 
RocketPort

Windows 2000, 
Windows XP Comtrol Utilities peer peer.exe
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Log Functions
Log Functions All logging functions are found under the File menu. To start keeping a log, select 
Log to Disk from the File menu. The other options on this menu are View Disk Log, 
Clear Disk Log, Clear Screen, and Exit.

Using Peer To use peer, simply type in commands at the : prompt. (It may be necessary to 
press Enter to make the : prompt appear.) For example, to examine COM5, type: 
PORT COM5 <Enter>

To gather some information about the port, type: STAT <Enter>. This should 
return details about the port.
To turn on monitoring of any calls into driver (events), type: MON EV <Enter>

To send strings and commands to attached peripherals—for example, to send 
“ATH0” to a modem—type: SEND ATH0 <Enter>. A return and linefeed are always 
appended to each string sent.

Other Peer 
Commands

Enter commands at the : prompt and follow each command with Enter.

Keep in mind that all commands are processed in the device driver, and that Peer 
simply acts as a conduit for this information. 
For more information, see the Peer.hlp help file.

Command Effect

MON TX Monitor data being transmitted through the selected port.

MON RX Monitor data being received through the selected port.

M Turn off all monitoring.

? Display Peer Tracer command summary.

PORT COMxx Change port being examined to COMxx.
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Troubleshooting and Technical Support

This section contains troubleshooting information for your Comtrol device. You 
should review the following subsections before calling Technical Support because 
they will request that you perform many of the procedures or verifications before 
they will be able to help you diagnose the problem.

Troubleshooting

If you are having trouble with a RocketPort or RocketModem, try the following.
Note: Most customer problems reported to Technical Support are traced to cabling 

or network problems.
1. Verify that you are using the correct types of cables in the correct places and 

that all cables are tightly connected.
2. If you have an ISA adapter, make sure that you set the I/O DIP switch 

correctly.
3. Enable the Verbose Event Log feature under the Setup Options tab and then 

reboot the system.
4. Verify that you are addressing the port correctly. In many applications, device 

names above COM9 require the prefix \\.\ to be recognized. For example, to 
reference COM20, use \\.\COM20 as the file or port name.

5. Use the Test Terminal program (wcom32.exe) to troubleshoot communications 
on a port-by-port basis.

6. Use the Port Monitor program (portmon.exe) to check for errors, modem 
control, and status signals. In addition, it provides you with raw byte input 
and output counts.

7. Use the Peer Tracer program (peer.exe) to trace driver events.
8. Remove and reinstall the driver.

Before calling 
Technical Support

Comtrol has a staff of support technicians available to help you. 
You should review the Troubleshooting section and run through the diagnostics 
before calling Technical Support. In addition, the web site has On-Line Technical 
Support available. If you call for Technical Support, please have the following 
information available.

Item Information

Hardware Type 

Hardware Serial Number*

Operating system type

Driver part number and revision level of 
Rocket.sys

Server computer make, model, and speed

Other serial port adapters installed in the 
server and their COM port numbers

Devices connected to the board
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Technical Support
Technical Support

If you need technical support, contact Comtrol using one of the following methods.

Contact 
Method

Corporate 
Headquarters Comtrol Europe

FAQ/Online http://support.comtrol.com/support.asp

Downloads http://support.comtrol.com/download.asp

Email  support@comtrol.com support@comtrol.co.uk

Web site  http://www.comtrol.com http://www.comtrol.co.uk

Fax (763) 494-4199 +44 (0) 1 869-323-211

Phone (763) 494-4100 +44 (0) 1 869-323-220
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